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Safety Information

Safety Information

TO MINIMIZE FIRE HAZARD OR INJURY BY ELECTRICAL SHOCK, DO NOT EXPOSE
THIS DEVICE TO RAIN OR HUMIDITY.

NOTE
A RISK OF ELECTRIC SHOCK A
DO NOT OPEN

A CAUTION
To minimize fire hazard or electric shock, do not remove the cover (or the rear
panel) of the device. Have all repairs performed by qualified service technicians.

. J

A The lightning symbol located in an equilateral triangle informs the user about

the existence of an uninsulated "dangerous voltage” inside the device, which can
have such an intensity as to cause injury by electrical shock.

. J

's A

A The exclamation mark symbol located inside an equilateral triangle informs the
user about important instructions for operation and maintenance in the attached
device documentation.

A WARNING
TO MINIMIZE FIRE HAZARD OR ELECTRIC SHOCK, DO NOT EXPOSE THIS
DEVICE TO RAIN OR HUMIDITY.

/\ cAuTioN
TO PREVENT FIRE HAZARD OR ELECTRIC SHOCK, ALIGN THE PLUG WIDE
BLADE WITH THE SOCKET WIDE SLOT AND PUSH THE PLUG AS FAR AS IT
GOES.

0| this symbol indicates that the device has double insulation between the
dangerous mains voltage and the user serviceable parts. In the case of servicing,
use only identical spare parts.

. J

Do not expose the appliance to the effects of dripping or spraying water and do not place
objects filled with a liquid such as vases on the appliance.

EN5
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Safety Information

IMPORTANT SAFETY INSTRUCTIONS

During the manufacture of this set-top-box, great attention has been paid not only

to meeting quality requirements, but also to providing safety which is a key factor in
designing all of our products. Providing security, however, requires your actions as well.
This document contains impartant information that will help you learn how to correctly
use this set-top box and its accessories to your satisfaction. Please read them carefully
before installation and using this set-top-box.

Installation

1. Read and observe the instructions - Please read all safety and operating instructions

before using this set-top-box. Adhere to all instructions.

Retain the instructions - Keep the safety and operating instructions for future use.

3. Heed the warnings - Observe all warnings on the set-top-box and in the operating
instructions.

4. Power supply - This set-top-box is powered from a DC power supply plug. To prevent
a risk of electric shock, please make sure to connect the power supply to your power
outlet correctly.

5. Sources of energy - To power this set-top-box, you may only use sources whose
specifications meet the nameplate ratings on the set-top-bax rear panel. If in doubt
about the tupe of energy source at home or in your office, please contact your set-
top-box dealer or an electrician. For set-to-boxes designed for battery operation or
powering from other energu sources, please refer to the operating instructions.

6. Overloading - Do not overload the power outlets and extension cords ta avoid risk
of fire or electric shock. Overloaded power outlets and extension cords, frayed power
cords, damaged or cracked conductor insulations and damaged plugs are dangerous
and may lead to electric shock or fire. Inspect the cord on regular basis and if it
appears that insulation damage or property deterioration may have occurred, ask a
qualified service technician for a replacement.

/. Power cord protection - Route the power cords so they are not likely to be stepped on
or damaged by placing objects on or against them, while pauing extra attention to the
points of their exit from the set-top-box.

8. Ventilation - Openings and hales in the unit's cabinet are designed for ventilation
to ensure reliable operation of the set-top-box and its protection from overheating.
There holes should not he covered or blocked. These holes should be never blacked
by placing the set-top-box on bed, sofa, mat or an air heating appliance. Do not
place this set-top-box in an enclosed space such as a fridge or a self unless proper
ventilation is provided or it this is inconsistent with the set-to-box manufacturer
requirements.

N
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Safety Information

Accessories - To avoid any danger, do not use any accessories other than those
recommended by this set-top-box manufacturer.

Do not expose the appliance to the effects of dripping or spraying water and do not
place objects filled with a liquid such as vases on the appliance.

Attention: Ensure safety when using electric energy. Any equipment or accessories
powered from the grid and connected to this unit must be marked with a certification
label on the equipment itself and must not be modified to avoid locking the safety
features. This will minimize potential risk of electric shock or fire. In case of any doubt,
please contact a qualified service technician.

Accessories - Do not put this set-top-box on an unstable cart, stand, tripod, console
or table. Otherwise, your set-top-box might fall on the floor, resulting in a serious
injury to children, adults or a serious damage to itself. Use this set-top-box only with
a cart, base, stand, console or table recommended by the manufacturer or supplied
with the set-top-box. Any mounting of the unit must be carried out according to

the manufacturer's instructions and the mounting accessories recommended by the
manufacturer should be used.

Take care while moving the cart with the set-top-box. Sudden stops, appluing
excessive farce and uneven surfaces may lead to the set-top-box damage.

Outdoor aerial grounding - If an outdoor aerial or cable system is connected to this
set-top-box, it's necessary that this aerial or cable system should be earthed ta provide
a certain protection against voltage surges and static charge formation. Section 810

of the National Electrical Code, ANSI/NFPA No. 70-1984 (Section No. 54 of the
Canadian Electrical Code, Part 1) provides instructions on proper grounding of the pole
and the supporting framework, grounding the connecting lead to the aerial’s discharge
unit, connecting to the grounding electrodes and grounding electrode requirements.
Power lines - The outdoor antenna system should not be located in the vicinity of
overhead power lines, other electric lighting or power lines or in such locations where
fall of the antenna system on such power lines or circuits could occur. When installing
an outdoor antenna system, take extreme care not to touch and/or come close to such
electric conductors or circuits as this might have lethal consequences. As installation
of an outdoor aerial could be dangerous, have this task made by professional aerial
installers.

Using

Cleaning - Prior to cleaning, please disconnect this set-to-box from your power outlet.
Do not use liquid cleaning agents or cleaning agents in sprays. Use a dampened
cloth for cleaning.

Objects which could get in touch with dangerous voltage points or “short-circuit” the
parts may cause fire or electric shock. Avoid spilling any liquid on the set-top-box.
Lightning thunderstorms - For increased protection of this set-top-box during a
lightning thunderstorm or for longer periods when the device will not be used,
disconnect the power cord from the power socket and disconnect the antenna or
cable system. This will protect your set-top-box from lightning and surge damage in
the grid.

EN7
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Safety Information

Repairs

17. Repairs - No not attempt to repair this set-top-box by yourself as opening the cabinet
and removing the covers mau expose you to a dangerous voltage or other risk. Have
all repairs performed by qualified service technicians.

18. Damage requiring a repair - In the following situations, disconnect your set-tap-box
from the power outlet and have it repaired by qualified service technicians:

. The power supply or power connecting lead has been damaged.

. Liquid or foreign objects have fallen into the set-top-box.

. The set-top-box has been exposed to rain or water.

. The picture does not appear correctly even if the operating instructions are

observed.
Only use the controls described in these user's manual. Incorrect settings of other
controls may lead to damage, while restoring normal operating condition of the
set-top-box involves a great deal of work of a qualified service technician.
E. The set-top-box has fallen on the ground or its cabinet has been damaged.
F. The set-top-box shows a apparent change in its operating behaviour which clearly
indicates a need to make a repair.

19. Spare parts - If any spare parts are required, ask your service technician to verify if
the used spare parts have the same safety specifications as the original ones. Using
the spare parts as specified by the set-top-box manufacturer will protect your from
the risk of fire, electric shock or other danger.

20. Safety check - After finishing any service job or repair of your set-top-box, ask your
service technician to perform manufacturer recommended safetu checks to verifu the
set-top-box safety operating condition.

21, Wall or ceiling mount - This unit can be mounted on the wall or under the ceiling
onlu in @ manner recommended by the manufacturer.

22. Heat - This device must be located away from any sources of heat such as radiators,
air heaters, stoves or similar appliances (including amplifiers) that produce heat.

O O w >
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Introduction m

Introduction
Information about this STB

Front panel

Rear panel

Antenna HDMI Output

Digital Audio Output TV Scart
for connection to the TV
ce _O I - — B
RFIN RFOUT COAXIAL RJ45 HDMI
T -—
RE L i ot USB port
0op througn LAN port DC Power input

for an external device

EN9
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m Introduction

Remote control 6. Menu (Menu)
(Open and close the menu screen)
7. Cursor / CH+,- (Previous/Next
channel) / VOL+,- (Increase/decrease
volume)
15. (Cursor: Navigation buttans to browse
5 the menu items)
’ (CH +/-: Previous/Next channel)
(VOL+/-:Increase/decrease volume)
8. OK button
(Confirm a menu selection)
9. RECORD (Record)
(Recording a TV program)
18 10. Numeric keys
’ (To enter numeric values and select a
channel by direct number entering)
1. USB
(Verify the Video menu)
12. MEDIA (Media)
(Verify the Record menu)
19. 13. TTX (Teletext - verify interactive
services)
14. TIMER TIMER (Timer)
20. (Setting the timer)
15. MUTE (Mute/unmute sound)
1 16. SUBTITLE (Subtitles on/off)
: 17.  Search backward /forward (Searching
backward /forward)
18. EXIT (Exit the menu)
12‘ 23' (Stop the playback or program
: : : : recording)
13. £ e 24, 20. EPG (Electronic programming guide)
14. 25. (Opening the electronic programming
guide menu)
21. BACK (Back)
26. (Switch to previous channel)
22. TV/RADIO (T\//radio)
(Switching between TV and radio
modes)
23. AUDIO (Audio)
(Select the sound mode and track)
1. STANDBY (Standby mode) 24. RES (Resolution - switch to the
(Turning the STB on or switching to HDMI resolution)
standbuy) 25. FAV (Favourite)
2. INFO (Information) (Open the list of favourites)
(Press to view information 26. RED/GREEN/YELLOW/BLUE button
on the current channel) (For interactive features / Buttons of
PLAY (Playback) the nested menu features)
Previous/Next (Previous/Next)
PAUSE (Pause / Enable the time-
shift feature)

STANDBY MUTE
&

INFO SUBTITLE
@ @

HWN -

AW
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System connection

System connection

General information

There many various tupes of TV sets and other devices that can be connected to this
STB. This manual describes the most common methods of connecting your equipment.

Connecting to a TV set

{DMI TV

Aerial

/

Scart cable

RF cable

celd
o °Il=

RFIN  RFOUT COADIAL e RS HOMI v oco

o

= p—_0 O
] 000

Stereo Amplifier

EN11
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Getting Started

Getting Started

Welcome

When using this STB for the first time, “Welcome" menu will appear.
Press the cursor keus to set Region, Language, Display Mode and Aspect Mode.
Highlight "OK" and press “OK" to start searching the channels.

Region < France >
Language English
Display Mode 720p@50HZ
Aspect Mode 4:3LB
{ o |

Installation

The Installation menu allows you to set channel searching and LCN Installation option.
1. Press the "MENU" button to show the main menu.
2. Press the "UP" or "DOWN" button to highlight “Installation”
and press "RIGHT" to open the “Installation” menu.
3. Press the "UP" or DOWN" cursar button to highlight the desired item, then press
“OK" to open the nested menu.
4. Press the "EXIT" button to exit.

¢ Auto Scan
» Channel Scan
LCN

Auto Scan (Automatic search)

The "Auto Search” menu allows you to set automatic channel searching.

1. Select "Auto Scan” and press "OK" to apen the "Auto Scan” menu.

2. Press the cursor buttons to set “FTA Only” (non-encoded only) and “T2 Signal Only”.
3. Highlight the “Search” item and press "OK" to start the automatic scan.

LYY

88 by B 15

12EN
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Channel Scan

The “Channel scan” menu allows you to set manual channel searching.
1. Select "Channel Scan” and press "OK" to open the Channel Scan menu.

Getting Started

2. Press the cursor buttons to set Scan Mode, Scan Band, Channel No., Frequency or
Bandwidth, then highlight “Search” and press "OK" to start the channel searching.

LT

Channel No.
Frequency
Bandwidth
Network Search
Search

Signal Intensity
Signal Quality

Lo

b

88

|ScanMode < Bychannel >, |
Scan Band UHF

CH37(666000KHz)
666000KHz
8MHz
No

—100%
— 1%

LCN (Logical channel numbering)

If the LCN (Logical channel numbering) feature is enabled, you cannot change the original

TV channel numbers created by searching.

To enable/disable the LCN feature, set the “LCN" to on/off.

Copuright © 2017, Fast CR, a. s
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Operation

Changing channels

There are three channel selection methods available - step-by-step browsing the channel
list, selecting by number and selecting from the screen channel list.

1.

2.

Step-by-step browsing the channel list:

To move in the channel list, press the arrow up or down button on the remote control.
Selecting by a number:

Enter the channel number directly using the numeric buttons, then press OK to select
the desired channel.

Selecting from the screen channel list:

You can also select the desired channel number directly in the screen channel list. To
display this list, use the main STB menu. For more details, please refer to "Editing
channels” section in this manual.

Opening the Electronic programming guide (EPG)

To open the EPG for all channels:

O RGIFENERENIE

Press "EPG" to open the EPG (Electronic programming guide) menu.

Press the cursor buttons to switch between the channel list and current/next events.
Press the GREEN button to set the event timer.

Press the RED button to display the “Time Bar” menu.

Press "OK" to display selected event information.

Press the "EXIT" button to return to the previous menu.

In the “Time bar” menu:

-
A

<>
«»
“«»

)_C (EPG  01:39 44 |
- (>) 0010 BBC NEWS 24
(>) 0010 BBC NEWS 24 BBC News (5) 0010 BBC NEWS 24
02:00~02:30 eng(1/1)
News

0008 Interecon

0009 BBC Parl  The Recor Commons Questions. The Re
0010 BBC NEWS Auntie's War on Smut . Proms on FOUR
0011 CBeebie  This is CBeebies!

0012 301

To exit the time bar.

Back to the current time.

Skip forward or backward in time in 30-minute steps.
Skip forward or backward in time 2-hour steps.

Skip forward or backward in time 24-hour steps.

319 01:30 02:00 02:30 03:00 3/19 01:30 02:00 02:30 03:00
x 2 .

0008 Interecon
0009 BBC Parl  The Recor Commons Questions The Re
0010 BBC NEWS Auntie's War on Smut . Proms on FOUR
. « Cancel « Now & Next 0011 CBeebie  This is CBeebies!
0012 301

© Time © Timer I (]

14 EN
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Editing channels

Editing channels

Edit Channel menu

1. Press the "MENU" buttan to show the main menu.

2. Press the "UP" or "DOWN" button to highlight “Edit Channel”
and press "RIGHT" to open the “Edit Channel” menu.

3. Press the "UP" or DBOWN" cursor button ta highlight the desired item, then press
"OK" to open the nested menu.

4. Press the "EXIT" button to exit.

EEEEEEEEEE————,
TV Channel List
Radio Channel List
Delete All

TV Channel List

1. In the Edit Channel menu, select "TV Channel List” and press “OK" to open the TV
Channel List menu.

2. Press the "UP and "DOWN" button to highlight the channel and then press OK to
preview the desired TV channel.

< ATV >
[Lock| Skip [Move] Edit |
5

0001 No Name

N i

CETE N

0002 YooPlay Ga
0003 E4+1
i
0005 SKY THREE DVBT
0006 Sky Snts No i
0007 Sky News PID:203/303/203
GI:1/32 FEC:3/4

Use this menu to set the favorites and to lock, skip, sort, delete or rename channels.

«  Press the "FAV" button and then press “OK” to edit the FAV (Favorite) feature.

«  Press the "RED" button to enable the “Lock” function. You will be prompted to enter
a password (default password is "000Q"); then press “OK" to lock the selected
channels.

EN 15
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Editing channels

«  Press the "GREEN" button to enable the “Skip” feature, then press "OK" to skip the
selected channel.

«  Press the "YELLOW" button to enable the "Move” feature, highlight the desired
channel and press OK to confirm. Press “UP" or “DOWN" button to select a new
position, then press “OK". This will move the channel to a new position.

«  Press the "BLUE" button to open the nested Edit channel menu.

«  Press "OK" again to cancel the relevant function.

«  Press the “colour” button again to exit the relevant function.

3. Press "Exit" to save and return to the "Edit Channel” menu.

Radio Channel List

1. In the Edit Channel menu, select "Radio Channel List” and press "OK" to open the
Radio Channel List menu.

2. Press the "UP and "DOWN" button to highlight the channel and then press OK to
listen to the desired radio channel.

Note:

Controlling in the "Radio Channel List” mode is basically the same as in the “TV
Channel List” mode except for one thing: As no image information is available In
the "Radio Channel List” mode, logo is always displayed on the right of the preview
window.

Delete All

1. In the Edit Channel menu, select “Delete All"

and press”"OK".

You will be prompted to enter password (default password is "0000").
2. A warning message window will appear.

Select “Yes"and press “OK" to delete all channels.

To cancel the deletion, select No and press OK.

Warning! Do you really want to delete
all channels?

“Yes iNo

16 EN
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ystem Settings

System Settings

System Setup menu

The System Setup alows you to set Language, TV Sustem, Lacal Time Setting, Timer

Setting, Parental Lock, OSD Setting, Favorite, Audio Description Setting and Other.

1. Press the "MENU" buttan to show the main menu.

2. Press the "UP" or "DOWN" button to highlight “System Setup” and press "RIGHT" to
open the System Setup” menu.

3. Press the "UP" or DBOWN" cursor button ta highlight the desired item, then press
"OK" to open the nested menu.

4. Press the "EXIT" button to exit.

~ SystemSetup

A ] Language

2 TV System

£ Local Time Setting

oy Timer Setting
Parental Lock

OSD Setting
3 Favorite

Audio Description Setting
pe
< Other

Language

This menu allows you to set the language of system, audio, subtitles and teletext and
enable the subtitle function.

!

E

% FirstAudio English
& Second Audio German
- Subtitle Language English
- Teletext English
®  Subtitle On
)

8

Subtitles: Off/Normal/Hard of Hearing

EN17
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System Settings

TV System

This menu allows you to set Video Resolution, Aspect Mode, Video Out and Digital Audio
Out.

Video Resolution: Setting various video signal resolutions (recommended resolution is
1080p/50 Hz)

Aspect Mode: Auto / 4:3PS / 4:3LB / 16:9 Video Out:CVBS/RGB

Digital Audio Out: LPCM Out (LPCM output) / BS Out (BS output)

Local Time Setting

This menu allows you to make region and time settings.

Region: This menu is used to change the region settings.

GMT Usage: This menu is used the set the GMT Usage.

The following options are available: By Region / User Define / Off

GMT Offset: This menu is only active if

"User Define” value has been set in the GMT Usage menu.

The GMT Offset range is “-11:30 ~ +12:00" in 30-minute increments.

Summer Time: The following options are available:0On/Off

Date: “Date” and “Time" menus are only active if the GMT Usage is set to “"Off".
Time: Press the numeric buttons ta set time.

18 EN
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System Settings

Timer Setting

This menu enables you to set the program timers. You can set up to 8 timers.
Timer Mode: Off / Once / Daily / Weekly / Monthly

Timer Service: Channel / Record

Wakeup Channel: Allows you to set the channel ta be tuned during the wakeup.
Wakeup Date: Press the numeric buttons to set the wakeup date.

Wakeup Time: Press the numeric buttons to set the wakeup time.

Duration: Press the numeric buttons to set the wakeup duration.

Parental Lock

This menu allows you to protect the menu a channels or to change your password.

1. In the "System Setup” menu, select “Parental Lock” and press "OK" - you will be
asked to enter a passward (default password is “0000").

2. When the correct password has been set using the numeric buttons, the child lock
menu appears.

Menu Lock: To lock the Edit channel / Installation menu. To open these menus, you must

enter a password.

The menu lock can be turned on/off.

Rating Lock: Off / AGE4 / AGES / AGEG / AGE7 / AGE8 / AGES / AGE1D / AGEN /

AGE12 / AGE13 / AGE14 / AGE1S / AGE16 / AGE1/ / AGE'8

New Password: To change the passwaord.

Confirm passwaord: To canfirm new password.

EN19
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System Settings

OSD Setting

This menu allows you to set the display duration and transparency of your OSD menu.
OSD Timeout: 1-10 seconds.
OSD Transparency: To set the OSD menu transparency ta Off / 10% / 20% / 30% / 40%.

Favorite

This menu allows you ta rename the favorite group.

1. In the System setup menu, select "Favorite”
and press OK to open the Favorite menu.

2. Select the desired group and press “OK" to open the virtual keyboard. Press the
cursor buttans to enter letters and numbers,
then press OK ta confirm. When the entering is finished, press the BLUE button to
caonfirm. The Favarite group name has been changed successfully.

Copuyright © 2017, Fast CR, a. s

Press the "EXIT" button to exit the group rename menu.
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System Settings

Audio Description Setting

This menu allows you to set, Use AD as default and AD Volume Offset: This is only
applicable to programs for which the sound description is broadcast by a TV station

Use AD as default: On/Off
AD Volume Offset: -3 ~ 3

Other

This menu allows you to set Antenna Power, Channel Play Tupe, Beeper, Auto Standbuy
and Loopthrough In Standbu.

Antenna Power (Power supply to the antenna): On/Off

When the "Antenna Power” is set to “On”, STB will provide 5V power supply to the
antenna.

When set to “"Off", this power supply will not he available.

Channel Play Type: All / Free / Scrambled

Beeper: On/Off

Auto Standby (Automatically switch to stand-by mode): 30Min /

1 Hour / 2 Hour / 3 Hour / Off Loopthrough In Standby: On/Off

If no command is entered on the STB front panel or the remote control for 30 minutes - 3
hours and no timer event occurs, the STB will automatically switch to standbu.

When Off is selected, the STB will not automatically switch to standbu.

EN 21
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Tools

Tools main menu

1. Press the "MENU" buttan to show the main menu.

2. Press the "UP" or "DOWN" button to highlight “Tools”
and press "RIGHT" to open the “Tools” menu.

3. Press the "UP" or DBOWN" cursor button ta highlight the desired item, then press
"OK" to open the nested menu.

4. Press the "EXIT" button to exit.

A 3 Information

7 Factory Setting

& Software Upgrade by OTA
- Upgrade By USB

e Remove USB device safely
£

-L‘:A

&

Information

This menu allows you to display some parameters of this STB.

1. Inthe "Tools" menu, select “Information” and press “OK" to open the information
window.

2. Press the "EXIT" button to exit.

Factory Setting

This menu allows you to restore the factory settings of this STB, deleting all existing
channels.
1. In the "Tools” menu, select the “Factory Setting” and press OK.
You will be prompted to enter password (default password is "0000").
2. A confirmation window will pop up.
To restore the factory settings and delete all channels, press “Yes”.
To cancel the factory settings restoration, select "No”.
3. Press the "EXIT" button to exit.

22EN
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Software Upgrade

This unit offers features for the user to update the software version - either wirelessly

(OTA) or using a USB flash drive.

1. Open the “Tools” menu, select “Software Upgrade by OTA"or " Software Upgrade bu
USB" and press OK - Software Upgrade menu will be shown.

2. Press the cursor buttons ta select a desired option and then highlight “Start” and
press OK to start the upgrade.

3. Press the "EXIT" button to exit.

[

% )

7 Bandwidth x Mhz
#%  Download PID XXX
W Start

i

{2 signal Intensity 0%
8 Signal Quality 10%

Remove USB device safely

In the "Tools” menu, select "Remove USB device safely”.
Press OK to confirm. A window will pop up.
Press "OK" again.

Disk Remove

EN 23
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Network/games

Network
Network
This menu allows you to set network options, watch weather forecast or listen to internet
radio.
Network Setting: Net choose (selecting the network connection methad)
Settings (setting network parameters)
Network Application: Radio Channel (listening ta internet radios)
Weather Channel (displaying weather forecast)
e
F ]
% Network Application
:
L1
®
Games

Game (Games)

This menu allows you to play games.

1. Press the "MENU" button to show the main menu.

2. Press the "UP" or "DOWN" button to highlight “Game”and press “RIGHT" to open the
Game menu.

3. Press the "UP" or DOWN" cursor button to highlight the desired item, then press
"OK" to open the game.

4. Press the "EXIT" button to exit.

7 Othello
Sudoku

who e B oS
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Multimedia player

Multimedia player

Multimedia player main menu

Make sure that external data storage device is cannected to the USB port.

1. Press the "MENU" buttan to show the main menu.

2. Press the "UP" or "DOWN" button to highlight “Media Player” and press the “RIGHT”
button to open the multimedia player menu.

3. Press the "UP" or DBOWN" cursor button ta highlight the desired item, then press
"OK" to open the nested menu.

4. Press the "EXIT" button to exit.

¢ Records
Video
Music
Image
HDD Information
DVR Setting

Bl = RN

Media Playback

This feature allows you to play bacl files from the USB port.

Note:
Only the disc specified in the settings is available for the recordings, for other media,
you can switch between front and rear USB input if both of them are in use.

1. In the "Media plauer” menu, press “1" to select “Record”, “Video"”, “Music” or “Image”

option.

Press “OK" to open Media Plauback menu.

3. Press "UP" and "DOWN" cursor buttons to select a desired multimedia file and press
"OK to start playback.

4. Press the "EXIT" button to exit.

N

2. 7 | swear.mp3

3. B Why.mp3

4. [ Lonely.mp3 ©  840.mp3

5. [ Because.mp3 B3IRE

of

000040 00:0332

O /xx/xxx/Music W« >E » W

« PlayList «FAV  FAVAI « Edit

~1- Switch ~2-Sort WFo RepeatM &7 Exit
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Multimedia player

Record:

RED button: Press the RED button to open the rename window.

GREEN button: Move the highlight over a program to be locked. Press the GREEN button
- you will be asked to enter a password. The default password is "0000". Once the correct
password is set, the program is locked. To unlock the program, press the GREEN button again.
“YELLOW" button: Press the "YELLOW" button to delete a recorded file.

“1" button: Press to switch among Music /Image /Video /Record tabs.

EXIT (End) button: Return to the parent directory.

Video:

BLUE button: Press the "BLUE" button to open the nested Edit channel menu.

“1" button: Press to switch among Music /Image /Video /Record tabs.

“2" button: Press the button “2" to open the sorting. You can sort by Name / Time / Size.
EXIT (End) button: Return to the parent directory.

An external subtitle file's name must match the video file name. National alphabets use
Unicode coding. Press the BLUE button for further selections.

To enable the video embedded subtitles, press SUBTITLE button.

Music:

"RED" button: Press the "RED" button to displau and edit the plauylist.

GREEN button: Move the highlight over the file to be added in the plaulist, then press
the GREEN button to add. Favorite icon will appear on the file. Press again to cancel the
favorite and delete the file from the playlist.

YELLOW button: Press YELLOW button to add all files in the current directory in the
playlist. Press this button again to delete all files in the current directory from the playlist.
BLUE button: Press the "BLUE" button to open the nested Edit channel menu.

“1" button: Press to switch among Music /Image /Video /Record tabs.

“2" button: Press the button “2" to open the sorting window.

You can sort by Name / Time / Size / Favorite.

“INFO" (Information) button: Press the "INFO" button to select a playback mode.

You can select from Repeat Folder / Random Folder / Repeat One.

EXIT (End) button: Return to the upper directory.

Image:

"RED" button: Press the "RED" button to displau and edit the playlist.

GREEN button: Move the highlight over the file to be added in the plaulist, then press the
GREEN button to add. Favorite icon will appear on the file.

YELLOW button: Press YELLOW button to add all files in the current directory in the
playlist. Press this button again to delete all files in the current directory from the playlist.
BLUE button: Press the "BLUE" button to open the nested Edit channel menu.

“1" button: Press to switch among Music /Image /Video /Record tabs.

“2" button: Press the button “2" to open the sorting window.

You can sort by Name / Time / Size / Favorite.

“INFO" (Information) button: Press “INFO" to open the image settings.
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Multimedia player

“3" button: Press “3" to display images in the multiple display mode
EXIT (End) button: Return to the parent directory.

HDD Information
This menu allows you to display some parameters of the exchangeable disc.

1. In the Media Player menu, select “HDD Information”
and press “OK" to open the hard disc information window.
2. Press the "EXIT" button to exit.

4 | USB DiskA: xxxG bytes
7 m
&
Volume XXXX
- Total Size XXXxx bytes
2 Free Size Xxxx bytes
Rec Size XXxx bytes
L TMS Size XXXX bytes
8 File System NTFS
& Format & DVR Set

Press the YELLOW button to open the Format menu.

+  Format FAT/NTES
Press "LEFT" or "RIGHT" cursor buttons to change the Disk Mode settings.
Press OK to format. Press “Cancel” to cancel the settings.
ATTENTION: The formatting will BEFINITELY erase the entire disc contents! Be
cautious.

+  DVR Set REC&TMS/Record/Timeshift
Press the BLUE button to open the DVR Set menu (DVR settings).
Press "LEFT" or "RIGHT" cursor buttons to change the DVR tupe settings.
Press "OK" to confirm. Press “Cancel” to cancel the settings.

Format DVR Set
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Multimedia player

DVR Settings

This menu allows you to set the DVR Setting parameters.

In the "Media Player” menu, select "DVR Setting” and press “OK" to open the “DVR
Settings” menu. Press the "UP" or "DOWN" cursor button to select the desired item, then
press the “LEFT" or "RIGHT" cursor button ta change the setting. Press the "EXIT" buttan

to exit.
Timeshift: Pause/Off/Auto
Jump: 30sec/Imin/5min/10min/15min/20min/30min

Timeshift to Record
(Recording time shift): On/Off

PS Record: On/Off
After Recording: Watch TV/Go to Standby-mode
[
Jump 30sec
Timeshift to Record Off

PS Record Off
After Recording Go to Standby-mode

Bl BB SN
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Time shift / recording

Time shift / recording

Connecting a Mass Storage Device to the USB port will enable the Time Shift/Record
feature far a broadcast program.

«  Pause the program being broadcast and resume the watching later on (Time Shift
feature).

*  Record the broadcast program.

« If the Mass Storage Device is out of free space, the broadcast recording operation will
stop.

Note:

For recording or the time-shift feature, please use a USB 2.0 disc.

For the time-shift and recording feature, please use a USB flash disc with a higher
capacity or a hard disc (> 2 GB).

Timeshift

Starting

*  You can launch the Time Shift function in the view mode by pressing the "PAUSE"
button (when the DVR Setting is set to Pause - recommended).

«  Press the "RIGHT" or "LEFT" button to move the cursor to the time you want to
display. Press OK to confirm.

Play 00:02:37 00:05:37 =

—_— S100%
412 188 1857s
>

Playback

During the playback, you can perform the following actions:
*  Press "PAUSE" to stop the playback temporarily

*  Press "FORWARD" to fast forward the playback

*  Press "BACKWARD" to backward the playback

To stop the time-shift
To stop the TimeShift feature, press “STOP".
Note: The time shift is not available during playback.
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Time shift / recording

Record

Instantaneous record
+  To start recording the main channel immediately, press "RECORD" in the view mode.
*  Press "RECORD" once again to set the time duration.
To stop the recording, press “STOP” - a confirmation window will appear. In 2
recordings are in progress, please select the one to be stopped.
«  To stop the recording, select "Yes". To resume recording, select "No”.

Timer recording
*  You can open the timer setting menu and set the timer recording using EPG or the
System Setup option.

Note:
You may perform up to 2 recordings from different multiplexes simultaneously. While
the recording feature 1 is enabled, you can watch any other program.
While the recording feature 2 is enabled, you can watch another program from the
| same multiplex only.

Note:

For the recording and time-shift feature, please use a USB disc or a USB 2.0 flash disc
from a reliable manufacturer, such as SAMSUNG, HITACHI a SONY. Some USB devices
may not be supported because of low quality. For USB 3.0 devices, please always use a
USB 2.0 connection cable.
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Troubleshooting

Troubleshooting

Problem

Possible cause

What to do

Standby mode
indicator is not lit

Power cord disconnected
Blown power supply fuse.

Check the power cord
Check the fuse

No signal has been
captured

Discannected antenna
Damaged / incorrectly adjusted
antenna

You are outside the digital
signal coverage area

Check the antenna cord
Check the antenna
Please consult your dealer

No picture and sound

No Scart/AV input has been
selected on your TV

Switch to another channel

Encoded channel
message

The channel is encoded

Select an alternate channel

No response to the
remote control

The receiver is turned off
The remote control is not
pointing in the right direction
The front panel is covered
The batteries in the remote
control are flat

Connect and turn it on

Point the remote control at the
front panel

Check for obstacles

Replace the batteries in the
remote control

Forgotten code to
lock the channels

To unlock the channels, please
install the channels again

Forgotten code to
lock the menu

Please contact the customer
support

The remote control
fails to control your
STB

(1) The batteries in the remote
control need to be replaced

(2) There is an obstacle
blacking the signal path
between the remote control
and the set-top-box.

(1) Replace the batteries

(2) Please check if there is
any barrier to the signal
transmission between the
remote control and the
receiver.

When the STB is
brought in another
room, the digital
broadcast cannot be
received

The antenna new connection
point may be part of a
distribution system that may
reduce the digital signal level
received by the set-top-box.

Check the direct connection
from the antenna

Copuyright © 2017, Fast CR, a. s
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m Technical specifications

Technical specifications

TUNER AND CHANNEL + VF INPUT CONNECTOR x 1
(IEC TYPE, IEC169-2, FEMALE TYPE)
+ VF OUTPUT CONNECTOR x 1
(IEC TYPE, IEC169-2, MALE
(BYPASS LOOP))
+ FREQUENCY BAND:
174MHz ~ 230MHz (VHF)
470MHz ~ 862MHz (UHF)
+ SIGNAL LEVEL:
-15 ~ -70dBm
DECODER
+ Video decoder + MPEG-2 MP@HL, AVC/H.264 HP @L.4.1
MPEG-4 ASP, HEVC/H.265 HP @L4.1 SUPPORT
+ Audio decoder + MPEG-1 Lauer 1,2/PCM/HE-AAC V1.0
ICES58 SPDIF/Dolby D+ and Dolby D
« INPUT SPEED + MAX. 48 Mbit/s
+ VIDEQ FORMATS « 4:3/16:9 SWITCHABLE
« VIDEO OUTPUT + HDMI, CVBS
+ MODULATION + QPSK, 160AM, 640AM, 2560AM
CONNECTION
. TUNER » ANTENNA INPUT x 1, VF OUTPUT x 1
. HOMI » HDMI OUTPUT x 1
- DATA PORT " USB X2
POWER SOURCE
« INPUT VOLTAGE « 12 Vss, TA
Note:

The design and technical specifications are subject to change without prior notice.

. J

X15958Y. s
Manufactured under the license of Dolby Laboratories. Dolby and the double D symbol
are the trademarks of Dolby Laboratories.
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INSTRUCTIONS AND INFORMATION ON DISPOSING OF USED PACKAGING MATERIALS
Dispose of used packaging material at a site designated for waste in your municipality.

This symbol on products or original documents means that used electric or
electronic products must not be added to ordinary municipal waste. For proper
disposal and recycling, take these products to designated collection points.

Or in some European Union states or other European countries the products

can be returned to the local retailer when buying an equivalent new product.
Disposing of this product correctly helps save valuable natural resources and
prevents damage to the environment by improper waste disposal. Ask your local
authorities or collection facility for more details. In accordance with national
regulations penalties may be imposed for the incorrect disposal of this type of
waste.

E DISPOSING OF USED ELECTRICAL AND ELECTRONIC EQUIPMENT
|

For business entities in European Union states
To dispose of electric or electronic devices, ask your retailer or supplier for the
necessary information.

Disposal in other countries outside the European Union

This sumbol is valid in the European Union. If you wish to dispose of this
product, request the necessary information about the carrect disposal method
from the local council or from your retailer.

FAST CR, a.s. hereby declares that the radio device type SDB 5104TD conforms
c € to the 2014/53/EU directive.

For full version of the EU declaration of conformity, please refer to www.sencor.
eu website.

The text, design and technical specifications may be changed without prior notice and we
reserve the right to make these changes.
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SENCOR

EN Warranty conditions

Warranty card is not a part of the device packaging.

This product is warranted for the period of 24 months from the date of purchase to the end-user. Warranty is limited
to the following conditions. Warranty is referred only to the customer goads using for common domestic use. The
claim for service can be applied either at dealer's shop where the product was bought, or at below mentioned
authorized service shops. The end-user is obligated to set up a claim immediately when the defects appeared but
only till the end of warranty period. The end user is obligated to cooperate to certify the claiming defects. Only
completed and clean (according to hugienic standards) product will be accepted. In case of eligible warranty claim
the warranty period will be prolonged by the period from the date of claim application till the date of taking over
the product by end-user, or the date the end-user is obligated to take it over. To obtain the service under this
warranty, end-user is obligated to certify his claim with duly completed following documents: receipt, certificate of
warranty, certificate of installation.

This warranty is void especially if apply as follows:
Defects which were put on sale.
Wear-out or damage caused by common use.
The product was damaged by unprofessional or wrang installation, used in contrary to the applicable instruction
manual, used in contrary to legal enactment and common process of use or used for another purpase which
has been designed for.
The product was damaged by uncared-for or insufficient maintenance.
The product was damaged by dirt, accident of force majeure (natural disaster, fire, and flood).
Defects on functionality caused by low duality of signal, electromagnetic field interference etc.
The product was mechanically damaged (e.g. broken button, fall).
Damage caused by use of unsuitable medis, fillings, expendable supplies (batteries) or by unsuitable working
conditions (e.g. high temperatures, high humidity, quakes).
Repair, modification or other failure action to the product by unauthorized person.
End-user did not prove enough his right to claim (time and place of purchase).
Data on presented documents differs from data on products.
Cases when the claiming product cannot be indentified according to the presented documents (e.g. the serial
number or the warranty seal has been damaged).

Authorized service centers
Visit www.sencor.eu for detailed information about autharized service centers.
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